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1 HP DeskJet 4720 series Help

Learn how to use your HP DeskJet 4720 series.

● Get started on page 3

● Print on page 27

● Use Web Services on page 39

● Copy and scan on page 47

● Manage ink cartridges on page 55

● Connect your printer on page 65

● Technical information on page 105

● Solve a problem on page 79
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2 Get started

● Printer parts

● Control panel features

● Control panel lights and display icons status

● Load media

● Change the default paper size detected by printer

● Load an original on the scanner glass

● Paper basics

● Open the HP printer software (Windows)

● Sleep mode

● Quiet Mode

● Auto-Off 
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Printer parts

1 Paper-width guide

2 Input tray

3 Input tray shield

4 Scanner lid

5 Scanner glass

6 Control panel

7 Front door

8 Output tray

9 Output tray extender (also referred to as the tray extender)

10 Ink cartridges

11 Cartridge access door

12 Power connection

13 USB port
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Control panel features
Overview of buttons and lights

Feature Description

1 Control panel display : Indicates number of copies, media errors, wireless status and signal strength, Wi-Fi 
Direct status, and ink levels.

2 Cancel button: Stops the current operation.

3 Wireless button: Turns on or off the printer wireless capabilities.

Wireless light: Indicates whether the printer is connected to a wireless network.

4 Wi-Fi Direct button: Turns on or off Wi-Fi Direct.

Wi-Fi Direct light: Indicates the on or off status of Wi-Fi Direct.

5 Start Copy Color button: Starts a color copy job. To increase the number of color copies, press the button 
multiple times. Copying will start two seconds after the last button press.

6 Power button: Turns the printer on or off.

7 Ink Alert light: Indicates low ink or ink cartridge problems.

8 Resume button: Resumes a job after a disruption (for example, after loading paper or clearing a paper jam).

Resume light: Indicates the printer is in a warning or error state.

9 Information button: Prints out a printer information page. Press the button in combination with the 
Wireless button, the Wi-Fi Direct button, or the HP ePrint button to get more specific help pages tied to 
each of those buttons.

Information light: Indicates that you can press the Information button to get help.
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Feature Description

10 HP ePrint button: Turns HP ePrint on or off.

HP ePrint light: Indicates the on or off status of HP ePrint. A blinking light indicates a problem with the 
connection to Web Services.

11 Start Copy Black button: Starts a black-and-white copy job. To increase the number of black-and-white 
copies, press the button multiple times. Copying will start two seconds after the last button press.

Control panel display icons

Icon Description

Number of copies icon: Shows the number of copies when you are copying documents, and alternates 
between the letter E and a number when the printer is in an error state.

Error icon: Indicates an error.

Paper Error icon: Indicates a paper-related error.

Wireless status icons: Show the status of a wireless connection.

The wireless status icons consist of three icons, the Wireless icon ( ), the Wireless Attention icon 

( ), and the Signal Bars icon ( ).

Wi-Fi Direct icon: Indicates Wi-Fi Direct is on or is in the process of being connected.

Ink Level icons: The left ink icon shows the estimated ink level of the tri-color cartridge, and the right 
icon shows the estimated ink level of the black cartridge.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you 
receive a low-ink warning message, consider having a replacement cartridge available to avoid 
possible printing delays. You do not need to replace cartridges until the print quality becomes 
unacceptable.
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Control panel lights and display icons status
Power button light

●

Status Description

On The printer is on.

Off The printer is powered off.

Dimmed Indicates the printer is in Sleep mode. The printer automatically enters Sleep mode after 5 
minutes of inactivity.

Blinking The printer is processing a job. To cancel the job, press the Cancel button ( ).

Fast blinking If the cartridge access door is open, close it. If the cartridge access door is closed and the light 
is fast blinking, the printer is in an error state that you can resolve by following the on-screen 
messages from the computer. If you do not see any on-screen messages, try printing a 
document to generate an on-screen message.

Wireless light and icons

● The Wireless light next to the Wireless button ( ) and the wireless status icons on the control panel 

display work together to indicate the status of a wireless connection.

Status Description

The Wireless light, the Wireless icon, and the Signal Bars icon 
are on.

The printer is connected to a wireless network.

The Wireless light is off. The wireless capability of the printer is off. To turn on the 

wireless capability, press the Wireless button ( ).

The Wireless light is blinking, the Wireless icon is on, and the 
Signal Bars icon are cycling.

The printer is connecting to a wireless network or is in the Wi-
Fi Protected Setup (WPS) push mode.

The Wireless light blinks for three seconds and then turns off. The wireless capability of the printer is disabled.

Change the wireless settings. For more information, see 
Wireless settings on page 72.
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Status Description

The Wireless light is blinking, and the Wireless icon and 
Wireless Attention icon are on.

There is no wireless signal.

– Make sure your wireless router or access point is 
powered on.

– Move the printer closer to the wireless router.

The Wireless light is blinking, the Wireless icon is on, and the 
Wireless Attention icon is blinking.

One of the following might have occurred.

– The printer has a problem connecting to the wireless 
network.

– An error occurs or an overlap session is detected when 
using WPS.

Press the Wireless button ( ) and the Information button 

( ) together to run the wireless test, and then review the 

test report for information on how to solve the problem.

Wi-Fi Direct light and icon

●

Status Description

The Wi-Fi Direct light and icon are on. Wi-Fi Direct is turned on and ready to use.

To learn how to connect to your printer using Wi-Fi Direct, see 
Connect wirelessly to the printer without a router 
on page 69.

The Wi-Fi Direct light and icon are off. Wi-Fi Direct is off.

To turn on Wi-Fi Direct, press the Wi-Fi Direct button ( ).

The Wi-Fi Direct light is blinking. The printer is connecting to a mobile device in the Wi-Fi 
Protected Setup (WPS) push mode. Press the Wi-Fi Direct 

button ( ) to finish connecting.

The Wi-Fi Direct light blinks fast for three seconds, and then 
stays on.

The printer already has the maximum number of Wi-Fi Direct 
connection and another device is trying to connect to the 
printer with Wi-Fi Direct.

The Wi-Fi Direct light blinks fast for three seconds, and then 
turns off.

Wi-Fi Direct is disabled. For more information, contact the 
person who set up the printer.

HP ePrint light

●
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Status Description

The HP ePrint light is on. The HP ePrint feature is on and ready to use. For information 
about how to print documents using HP ePrint, see Print with 
HP ePrint on page 42.

The HP ePrint light is off. The HP ePrint feature is off.

To turn on HP ePrint, press the HP ePrint button ( ).

The HP ePrint light blinks for three seconds, and then turns 
off.

One of the following might have occurred.

– The Web Services have not been setup up.

– A mandatory update for the printer is available but has 
not been installed.

– The HP ePrint feature has been disabled.

Press the HP ePrint button ( ) and the Information button 

( ) at the same time to print a diagnostic page, and then 

follow the instructions on the page.

The HP ePrint light keeps blinking. The HP ePrint feature is turned on, but the printer is not 
connected to the Web Services server.

Press the HP ePrint button ( ) and the Information button 

( ) at the same time to print a diagnostic page, and then 

follow the instructions on the page.

Ink Level icons and Ink Alert light

● One of the Ink Level icons is blinking with no segment, and the Ink Alert light is on.

Cause Solution

One of the following might have occurred.

– The corresponding ink cartridge is missing.

– The corresponding ink cartridge is installed improperly, 
or still has plastic tape on it.

– If one of the ink cartridges is missing, the printer enters 
single-cartridge mode. To exit the single-cartridge mode, 
insert the corresponding ink cartridge. For more 
information about the single-cartridge mode, see Use 
single-cartridge mode on page 61.

– If both ink cartridges are installed in the printer, remove 
the corresponding ink cartridge, make sure there is no 
plastic tape on it, and then reinsert the ink cartridge 
securely. For more information, see Replace ink 
cartridges on page 58.

● Both Ink Level icons are blinking with no segment, and the Ink Alert light is blinking.
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Cause Solution

One of the following might have occurred.

– Both ink cartridges are missing.

– Both ink cartridges are installed improperly, or still have 
plastic tape on them.

– Both ink cartridges are incompatible or damaged.

– If there is no ink cartridge installed in the printer, install 
the ink cartridges.

– If both ink cartridges are installed in the printer, remove 
the cartridges, make sure there is no plastic tape on 
them, and then reinsert the ink cartridges securely.

– Make sure that you are using the correct HP ink 
cartridges for your printer.

– If the error persists, replace the ink cartridges. For 
information about how to replace ink cartridges, see 
Replace ink cartridges on page 58.

● For one of the Ink Level icons, only one segment is on.

Cause Solution

The corresponding ink cartridge is low on ink and will need to 
be replaced soon.

– Continue to print using the remaining ink. The quality of 
printed documents might be affected.

– If the print quality is poor, consider replacing the 
corresponding ink cartridge. For more information, see 
Replace ink cartridges on page 58.

● For both Ink Level icons, only one segment is on.

Cause Solution

Both cartridges are low on ink and will need to be replaced 
soon.

– Continue to print using the remaining ink. The quality of 
printed documents might be affected.

– If the print quality is poor, consider replacing the ink 
cartridges. For more information, see Replace ink 
cartridges on page 58.

● One of the Ink Level icons is blinking with no segment, the Ink Alert light is on, and the Resume light is 
blinking.

Cause Solution

One of the following might have occurred.

– A counterfeit or previously used ink cartridge is installed.

– The corresponding ink cartridge is very low on ink.

– If the corresponding ink cartridge is newly installed, it 
might be counterfeit or previously used. Refer to the 
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Cause Solution

message in the HP printer software for more 
information.

– If the corresponding ink cartridge is not newly installed, 

it is very low on ink. Press the Resume button ( ) to 

continue printing, and replace the ink cartridge when the 
print quality is no longer acceptable. For information 
about how to replace ink cartridges, see Replace ink 
cartridges on page 58.

● Both Ink Level icons are blinking with no segment, the Ink Alert light is on, and the Resume light is 
blinking.

Cause Solution

One of the following might have occurred.

– The counterfeit or previously used ink cartridges are 
installed.

– Both of the ink cartridges are very low on ink.

– If the ink cartridges are newly installed, they might be 
counterfeit or previously used. Refer to the message in 
the HP printer software for more information.

– If the ink cartridges are not newly installed, they are very 

low on ink. Press the Resume button ( ) to continue 

printing, and replace the ink cartridges when the print 
quality is no longer acceptable. For information about 
how to replace ink cartridges, see Replace ink cartridges 
on page 58.

Error icon, Paper Error icon, and Resume light

● The Error icon, the Paper Error icon, and the Resume light are on.

Cause Solution

There is no paper in the input tray. Load paper in the input tray.

For information about how to load paper, see Load media 
on page 15.

● The Error icon, the Paper Error icon, and the Resume light are blinking.
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Cause Solution

The printer receives a printing job, and detects that there is no 
paper in the input tray.

Load paper, and then press the Resume button ( ) to 

continue printing.

For information about how to load paper, see Load media 
on page 15.

Number of copies icon

● The Number of copies icon is alternating between the letter E and the number 1. At the same time, the 
Error icon, the Paper Error icon, and the Resume light are blinking.

Cause Solution

The printer receives a printing job, starts feeding paper, and 
detects that the paper width for the printing job is bigger than 
the width of the loaded paper.

Press either the Resume button ( ) or the Cancel button 

( ) to cancel the printing job and eject paper.

To avoid the paper size mismatch problem, do one of the 
following before printing.

– Change the paper size setting for the printing job to 
match the paper loaded.

– Remove all paper from the input tray, and then load 
paper that matches the paper size setting for the 
printing job.

TIP: You can change the default paper size automatically 
detected by the printer. For more information, see Change the 
default paper size detected by printer on page 19.

● The Number of copies icon is alternating between the letter E and the number 2. The Resume light is 
off.
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Cause Solution

The printer receives a single-page printing job, detects that 
the paper length for the printing job does not match the length 
of the loaded paper, and then prints out the page with errors.

To clear the error, press any button on the control panel or 
wait for two minutes.

To avoid the paper length mismatch problem, do one of the 
following before printing.

– Change the paper size setting for the printing job to 
match the paper loaded.

– Remove all paper from the input tray, and then load 
paper that matches the paper size setting for the 
printing job.

TIP: You can change the default paper size automatically 
detected by the printer. For more information, see Change the 
default paper size detected by printer on page 19.

● The Number of copies icon is alternating between the letter E and the number 2. At the same time, the 
Error icon, the Paper Error icon, and the Resume light are blinking.

Cause Solution

The printer receives a multi-page printing job, detects that the 
paper length for the printing job does not match the length of 
the loaded paper, and then prints out the first page of the job 
with errors.

– To cancel the printing job, press the Cancel button ( ).

– To continue printing the remaining pages, press the 

Resume button ( ). The remaining pages will have 

the same errors as the first page.

TIP: You can change the default paper size automatically 
detected by the printer. For more information, see Change the 
default paper size detected by printer on page 19.

● The Number of copies icon is alternating between the letter E and the number 3. At the same time, the 
Resume light and the Ink Alert light are blinking.

Cause Solution

The carriage inside the printer has stalled. Open the cartridge access door and make sure the carriage is 
not obstructed. Move the carriage to the right, close the 
cartridge access door, and then press the Resume button 

( ) to continue printing. See Jams and paper-feed issues 

on page 80 for more information.
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● The Number of copies icon is alternating between the letter E and the number 4. At the same time, the 
Error icon, the Paper Error icon, the Resume light, and the Ink Alert light are blinking.

Cause Solution

There is a paper jam. Clear the jam, and then press the Resume button ( ) to 

continue printing.

For more information, see Jams and paper-feed issues 
on page 80.

● The Number of copies icon is alternating between the letter E and the number 5. At the same time, all 
lights on the control panel are blinking.

Cause Solution

The scanner is not working. Turn off and turn on the printer.

If the problem persists, contact HP. The printer still prints even 
if the scanner is not working.

● The Number of copies icon is alternating between the letter E and the number 6. At the same time, all 
lights on the control panel are blinking.

Cause Solution

The printer is in an error state. Reset the printer.

1. Turn off the printer.

2. Unplug the power cord.

3. Wait a minute, and then plug the power cord back in.

4. Turn on the printer.

If the problem persists, contact HP.
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Load media
Select a paper size to continue.

To load full-size paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.

3. Insert a stack of paper into the input tray with the short edge down and the print side up, and slide the 
stack of paper down until it stops.
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4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Pull out the output tray and the tray extender.

To load small-size paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.
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3. Insert a stack of photo paper into the far-right side of the input tray with the short edge down and the 
print side up, and slide the stack of paper down until it stops.

4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Pull out the output tray and the tray extender.

To load envelopes

1. Raise the input tray.
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2. Slide the paper-width guide to the left.

3. Insert one or more envelopes into the far-right side of the input tray and slide the stack of envelopes 
down until it stops.

The side to be printed on should face up. The flap should be on the left side and facing down.

4. Slide the paper-width guide to the right against the stack of envelopes until it stops.

5. Pull out the output tray and the tray extender.
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Change the default paper size detected by printer
The printer can automatically detect whether the input tray has paper loaded and detect whether the loaded 
paper is large, small, or medium width. You can change the default large, medium, or small paper size 
detected by the printer.

To change the default paper size detected by the printer

1. Open the embedded web server (EWS). For more information, see Open the embedded web server 
on page 75.

2. Click the Settings tab.

3. In the Preferences section, click Tray and Paper Management, and then select the desired option.

4. Click Apply.
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Load an original on the scanner glass
To load an original on the scanner glass

1. Lift the scanner lid.

2. Load the original print-side down on the right corner of the scanner glass.

3. Close the scanner lid.
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Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15 
cm), 5 x 7 inches (13 x 18 cm), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, 
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers 
exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 
inches, and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

● HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo Paper to 
save you time and take the guesswork out of printing affordable, lab-quality photos with your HP 
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printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your 
photos are long lasting and vivid, print after print. Great for printing out an entire vacation's worth of 
photos or multiple prints to share.

Business documents

● HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavyweight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matte

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer 
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.

● HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies
The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, 
and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. 
Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.
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Open the HP printer software (Windows)
After installing the HP printer software, double-click the printer icon on the desktop or do one of the following 
to open the printer software:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then select 
the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

ENWW Open the HP printer software (Windows) 23



Sleep mode
● Power usage is reduced while in Sleep mode.

● After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.

● The Power button light is dimmed and the printer control panel display is off in Sleep mode.

To change the time to Sleep mode

1. Open the embedded web server (EWS). For more information, see Open the embedded web server 
on page 75.

2. Click the Settings tab.

3. In the Power Management section, click Energy Save Mode, and select the desired option.

4. Click Apply.
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Quiet Mode
Quiet Mode slows down printing to reduce overall noise without affecting print quality. Quiet Mode only works 
for printing with Normal print quality on plain paper. To reduce printing noise, turn on Quiet Mode. To print at 
normal speed, turn Quiet Mode off. Quiet Mode is off by default.

NOTE: In Quiet Mode, if you print on plain paper with the Draft or Best print quality, or if you print photos or 
envelopes, the printer works in the same way as when Quiet Mode is off.

To turn Quiet Mode on or off from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. Click the Quiet Mode tab.

3. Click On or Off.

4. Click Save Settings.

To turn Quiet Mode on or off from the Embedded Web Server (EWS)

1. Open the EWS. For more information, see Open the embedded web server on page 75.

2. Click the Settings tab.

3. In the Preferences section, select Quiet Mode, and then select On or Off.

4. Click Apply.
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Auto-Off
This feature turns the printer off after 2 hours of inactivity to help reduce energy use. Auto-Off turns the 
printer off completely, so you must use the Power button to turn the printer back on. If your printer 
supports this energy saving feature, Auto-Off is automatically enabled or disabled depending on printer 
capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode after 5 
minutes of inactivity to help reduce energy use.

● Auto-Off is enabled when the printer is turned on, if the printer does not have network or fax capability, 
or is not using these capabilities.

● Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer 
with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.
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3 Print

● Print from your computer

● Print from your mobile device

● Print with AirPrint

● Tips for print success
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Print from your computer
● Print documents

● Print photos

● Print envelopes

● Print using the maximum dpi

Print documents
Before printing documents, make sure you have paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 15.

To print a document (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print documents (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Specify the page properties.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for a USB connected printer. Locations for the options can 
vary from one application to another.

● Choose the paper size.
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NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

● Select the orientation.

● Enter the scaling percentage.

4. Click Print.

To print on both sides of the page (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. On the Layout tab, select an appropriate option from the Print on Both Sides Manually drop-down list.

6. After you print the first side, follow the on-screen instructions to reload the paper with the blank side up 
and top of the page down, and then click Continue.

7. Click OK to print.

To print on both sides of the page (OS X)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Paper Handling from the pop-up menu and set Page Order to Normal.

3. Set Pages to Print to Odd only.

4. Click Print.

5. After all of the odd numbered pages have printed, remove the document from the output tray.

6. Reload the document so that the end that came out of the printer is now going into the printer and the 
blank side of the document is facing toward the front of the printer.

7. In the Print dialog, return to the Paper Handling pop-up menu and set the page order to Normal and the 
pages to print to Even Only.

8. Click Print.

Print photos
Before printing photos, make sure you have photo paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 15.
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To print a photo on photo paper (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate photo size from the Paper Size drop-down list.

5. Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

NOTE:  After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout. 

To print a photo from the computer (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for a USB connected printer. Locations for the options can 
vary from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. Select an Orientation.

c. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Best or Maximum dpi

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix 
option.
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– Off: applies no changes to the image.

– Basic: automatically focuses the image; moderately adjusts image sharpness.

4. Select any other print settings you want, and then click Print.

Print envelopes
Before printing envelopes, make sure you have envelopes loaded in the input tray and the output tray is open. 
You can load one or more envelopes into the input tray. Do not use shiny or embossed envelopes or envelopes 
that have clasps or windows. For more information about loading envelopes, see Load media on page 15.

NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your 
word application.

To print an envelope (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then 
select the appropriate color in the Color area.

● Click Advanced to select the appropriate envelope size from the Paper Size drop-down list.

5. Click OK, and then click Print or OK in the Print dialog box.

To print envelopes (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for a USB connected printer. Locations for the options can 
vary from one application to another.

a. Select the appropriate envelope size from the Paper Size pop-up menu.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to 
Plain Paper.

4. Click Print.
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Print using the maximum dpi
Use maximum dots per inch (dpi) to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk 
space.

To print in maximum dpi mode (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Click the Paper/Quality tab.

5. From the Media drop-down list, select an appropriate paper type.

6. Click the Advanced button.

7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.

8. Select the appropriate paper size from the Paper Size drop-down list.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.

To print using maximum dpi (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for a USB connected printer. Locations for the options can 
vary from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate paper type

● Quality: Maximum dpi

4. Select any other print settings that you want, and then click Print.
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Print from your mobile device
With HP mobile printing technology, you can print from your smartphone or tablet to your printer easily.

If you are at home or office, to use the printing capabilities already on your smartphone or tablet to print:

1. Make sure your mobile device and printer are on the same network.

2. Select the photo or document you want to print and choose your printer.

3. Confirm print settings and print.

If you want to print without accessing the network, see Connect wirelessly to the printer without a router 
on page 69 for more information.

If you are on the road, you can print a document by sending an email with the HP ePrint app to your HP ePrint 
enabled printer. See Print with HP ePrint on page 42 for more information.

For more information, visit the HP Mobile Printing website ( www.hp.com/go/mobileprinting ).
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Print with AirPrint
Printing using Apple’s AirPrint is supported for iPad (iOS 4.2), iPhone (3GS or later), iPod touch (third 
generation or later), and Mac (OS X 10.7 or later).

To use AirPrint, ensure the following:

● The printer and the Apple device must be connected to the same network as your AirPrint enabled 
device. For more information about using AirPrint and about which HP products are compatible with 
AirPrint, go to www.hp.com/go/mobileprinting .

● Load paper that matches the paper settings of the printer.

TIP: You can change the default paper size automatically detected by the printer. For more 
information, see Change the default paper size detected by printer on page 19.
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Tips for print success
To print successfully, the HP ink cartridges should be functioning properly with sufficient ink, the paper should 
be loaded correctly, and the printer should have the appropriate settings.

Print settings do not apply to copying or scanning.

Ink tips

● Use original HP ink cartridges.

● Install both the black and tri-color cartridges correctly.

For more information, see Replace ink cartridges on page 58.

● Check the estimated ink levels in the ink cartridges to make sure there is sufficient ink.

For more information, see Check estimated ink levels on page 56.

● If the print quality is not acceptable, see Printing issues on page 88 for more information.

Paper loading tips

● Load a stack of paper (not just one page). All of the paper in the stack should be in the same size and 
type to avoid a paper jam.

● Load the paper with side to be printed on facing up.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.

For more information, see Load media on page 15.

Printer settings tips (Windows)

● To change default print settings, open the HP printer software, click Print & Scan , and then click Set 
Preferences. For information how to open the printer software, see Open the HP printer software 
(Windows) on page 23.

● To select the number of pages to print per sheet, on the Layout tab, select the appropriate option from 
the Pages per Sheet drop-down list.

● To view more printing settings, on the Layout or Paper/Quality tab, click the Advanced button to open 
the Advanced Options dialog box.

– Print in Grayscale: Allows you to print a black and white document using the black ink only. Select 
Black Ink Only, and then click OK . It also allows you to print a high quality black and white image. 
Select High Quality Grayscale, and then click OK .

– Pages per Sheet Layout: Helps you specify the order of the pages if you print the document with 
more than two pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet 
Layout drop-down list.

– HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved 
print quality.
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– Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on each 
side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding 
method from the drop-down list, and then click OK.

○ Booklet-LeftBinding: The binding side after folded into a booklet appears at the left side. 
Select the option if your reading habit is from left to right.

○ Booklet-RightBinding: The binding side after folded into a booklet appears at the right side. 
Select the option if your reading habit is from right to left.

NOTE: The preview on the Layout tab cannot reflect what you select from the Booklet drop-
down list.

– Pages to Print: Allows you to print the odd pages only, print the even pages only, or print all pages.

– Borderless Printing: Select this feature to print photos without border. Not all paper types support 
this feature. You will see an alert icon beside the option if the selected paper type in the Media 
drop-down list does not support it.

– Page Borders: Allows you to add borders to the pages if you print the document with two or more 
pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Page Borders 
drop-down list.

● You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the 
setting values that are appropriate for a particular kind of job, so that you can set all the options with a 
single click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click the 
Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type 
and quality.

● To print a black and white document using only black ink, choose the Paper Type/Quality from the pop-
up menu and choose Grayscale from the Color pop-up menu.
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Notes

● Original HP ink cartridges are designed and tested with HP printers and papers to help you easily 
produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe the purchased original HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

● Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement ink cartridge 
available to avoid possible printing delays. You do not need to replace the ink cartridges until the print 
quality becomes unacceptable.

● You can print your document on both sides of the paper manually.
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4 Use Web Services

● What are Web Services?

● Set up Web Services

● Print with HP ePrint

● Use HP Printables

● Use the HP Connected website

● Remove Web Services

● Tips for using Web Services
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What are Web Services?
HP ePrint

● HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, 
from any location. It's as simple as sending an email to the email address assigned to your printer when 
you enable Web Services on the printer. No special drivers or software are needed. If you can send an 
email, you can print from anywhere, using HP ePrint.

Once you have signed up for an account on HP Connected ( www.hpconnected.com ), you can sign in to 
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your printer's 
HP ePrint email address to print, and get help for HP ePrint.

HP Printables

● HP Printables allow you to easily locate and print preformatted web content, directly from your printer. 
You can also scan and store your documents digitally on the Web.

HP Printables provide a wide range of content, from store coupons to family activities, news, travel, 
sports, cooking, photos, and many more. You can even view and print your online images from popular 
photo sites.

Certain HP Printables also allow you to schedule the delivery of app content to your printer.

Preformatted content designed specifically for your printer means no cut-off text and pictures and no 
extra pages with only one line of text. On some printers, you can also choose paper and print quality 
settings on the print preview screen.
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Set up Web Services
Before you set up Web Services, make sure your printer is connected to the Internet using a wireless 
connection.

To set up Web Services

1. Open the embedded web server (EWS). For more information, see Open the embedded web server 
on page 75.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Setup , click Continue, and follow the on-screen instructions 
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer downloads and installs the update, and then restarts. 
Repeat the instructions from step 1 to set up Web Services.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.
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Print with HP ePrint
HP HP ePrint allows you to print to your HP ePrint-enabled printer anytime, from any location.

Before you can use HP ePrint, make sure the printer is connected to an active network providing Internet 
access.

To print a document using HP ePrint

1. Make sure you have set up Web Services.

For more information, see Set up Web Services on page 41.

2. Press the HP ePrint button ( ) and the Information button ( ) at the same time to print an 

information page, and then find the email address for your printer from the page.

3. Email your document to the printer.

a. On your computer or mobile device, open your email application.

NOTE: For information about using the email application on your computer or mobile device, see 
the documentation provided with the application.

b. Create a new email and attach the document to print.

c. Send the email to the printer email address.

The printer prints the attached document.

NOTE: Enter only the HP ePrint email address in the "To" field. Do not enter any additional email 
addresses in the other fields. The HP ePrint server does not accept email print jobs if there are multiple 
addresses in the "To" field or any address in the "Cc" field."

NOTE: The email will be printed once it is received. As with any email, there is no guarantee when or 
whether it will be received. You can check the print status on HP Connected (www.hpconnected.com).

NOTE: Documents printed with HP ePrint may appear different from the original. Style, formatting, 
and text flow may differ from the original document. For documents that need to be printed with a 
higher quality (such as legal documents), we recommend that you print from the software application 
on your computer, where you will have more control over what your printout looks like.

To turn off HP ePrint

▲ From the printer control panel, press the HP ePrint button ( ).

NOTE: To remove all Web Services, see Remove Web Services on page 45.

 Click here to go online for more information.
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Use HP Printables
Print pages from the web, without using a computer, by setting up HP Printables, a free service from HP. You 
can print coloring pages, calendars, puzzles, recipes, maps, and more, depending on the apps available in 
your country/region.

Go to the HP Connected website for more information and specific terms and conditions: 
www.hpconnected.com .
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Use the HP Connected website
Use HP’s free HP Connected website to set up increased security for HP ePrint, and specify the email 
addresses that are allowed to send email to your printer. You can also get product updates, more apps, and 
other free services.

Go to the HP Connected website for more information and specific terms and conditions: 
www.hpconnected.com .
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Remove Web Services
To remove Web Services, complete the following steps:

1. Open the embedded web server (EWS). For more information, see Open the embedded web server 
on page 75.

2. Click the Web Services tab, and then click Remove Web Services in the Web Services Settings section.

3. Click Remove Web Services.

4. Click Yes to remove Web Services from your printer.
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Tips for using Web Services
● Learn how to share your photos online and order prints. Click here to go online for more information.

● Learn about apps for printing recipes, coupons, and other content from the web, simply and easily. Click 
here to go online for more information.
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5 Copy and scan

● Copy documents

● Scan using the HP printer software

● Scan using Webscan

● Tips for copy and scan success
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Copy documents
NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality 
when copying.

To copy documents

1. Load paper in the input tray.

For information about how to load paper, see Load media on page 15.

2. Load the original print side down on the right front corner of the scanner glass.

For more information, see Load an original on the scanner glass on page 20.

3. Press either the Start Copy Black button ( ) or the Start Copy Color button ( ) to make a copy.

Copying will start two seconds after the last button press.

TIP: You can increase the number of copies by pressing the button multiple times.
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Scan using the HP printer software
● Scan to a computer

● Create a new scan shortcut (Windows)

● Change scan settings (Windows)

Scan to a computer
Before scanning to a computer, make sure you have already installed the HP recommended printer software. 
The printer and computer must be connected and turned on.

To scan a document or photo to a file (Windows)

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Select the type of scan you want and then click Scan .

● Choose Save as PDF to save the document (or photo) as a PDF file.

● Choose Save as JPEG to save the photo (or document) as an image file.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 51.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview 
screen.

To scan a document or photo to email (Windows)

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.
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3. In the printer software, click Scan a Document or Photo .

4. Select the type of scan you want and then click Scan .

Choose Email as PDF or Email as JPEG to open your email software with the scanned file as an 
attachment.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 51.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview 
screen.

To scan an original from HP printer software (OS X)

1. Open HP Scan.

HP Scan is located in the Applications/Hewlett-Packard folder at the top level of the hard disk.

2. Click Scan .

3. Choose the type of scan profile you want and follow the on-screen instructions.

Go online to learn more about using the HP Scan software. Learn how to:

● customize scan settings, such as image file type, scan resolution, and contrast levels.

● scan to network folders and cloud drives.

● preview and adjust images before scanning.

Create a new scan shortcut (Windows)
You can create your own scan shortcut to make scanning easier. For example, you might want to regularly 
scan and save photos in PNG format, rather than JPEG.

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Click Create New Scan Shortcut .
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5. Enter a descriptive name, choose an existing shortcut on which to base your new shortcut, and then click 
Create .

For example, if you are creating a new shortcut for photos, choose either Save as JPEG or Email as 
JPEG . This makes available the options for working with graphics when scanning.

6. Change the settings for your new shortcut to meet your needs, and then click the save icon to the right 
of the shortcut.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 51.

Change scan settings (Windows)
You can modify any of the scan settings either for a singular use or save the changes to use permanently. 
These settings include options such as page size and orientation, scan resolution, contrast, and the folder 
location for saved scans.

1. Load the original print side down on the right front corner of the scanner glass.

2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. In the printer software, click Scan a Document or Photo .

4. Click the More link in the top right corner of the HP Scan dialog.

The detailed settings pane appears on the right. The left column summarizes the current settings for 
each section. The right column allows you to change the settings in the highlighted section.

5. Click each section at the left of the detailed settings pane to review the settings in that section.

You can review and change most settings using drop-down menus.

Some settings allow greater flexibility by displaying a new pane. These are indicated by a + (plus sign) at 
the right of the setting. You must either accept or cancel any changes on this pane to return to the 
detailed settings pane.

6. When you have finished changing settings, do one of the following.

● Click Scan . You are prompted to save or reject the changes to the shortcut after the scan is 
finished.

● Click the save icon to the right of the shortcut, and then click Scan .
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Go online to learn more about using the HP Scan software. Learn how to:

● customize scan settings, such as image file type, scan resolution, and contrast levels.

● scan to network folders and cloud drives.

● preview and adjust images before scanning.
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Scan using Webscan
Webscan is a feature of the embedded web server that lets you scan photos and documents from your printer 
to your computer using a web browser.

This feature is available even if you did not install the printer software on your computer.

NOTE: By default, Webscan is off. You can enable this feature from the EWS. 

If you are unable to open Webscan in the EWS, your network administrator might have turned it off. For more 
information, contact your network administrator or the person who set up your network.

To enable Webscan

1. Open the embedded web server. For more information, see Open the embedded web server 
on page 75.

2. Click the Settings tab.

3. In the Security section, click Administrator Settings.

4. Select Webscan to enable Webscan.

5. Click Apply.

To scan using Webscan

Scanning using Webscan offers basic scan options. For additional scan options or functionality, scan from the 
HP printer software.

1. Load the original print side down on the right front corner of the scanner glass.

For more information, see Load an original on the scanner glass on page 20.

2. Open the embedded web server. For more information, see Open the embedded web server 
on page 75.

3. Click the Scan tab.

4. Click Webscan in the left pane, change any settings, and then click Start Scan .
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Tips for copy and scan success
Use the following tips to copy and scan successfully:

● Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as 
part of the image.

● Load your original, print side down, on the right front corner of the glass.

● To make a large copy of a small original, scan the original into the computer, resize the image in the 
scanning software, and then print a copy of the enlarged image.

● To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the 
software.
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6 Manage ink cartridges

This section contains the following topics:

● Check estimated ink levels

● Order ink supplies

● Replace ink cartridges

● Use single-cartridge mode

● Cartridge warranty information

● Tips for working with cartridges
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Check estimated ink levels
You can easily check the ink supply level to determine how soon you might need to replace an ink cartridge. 
The ink supply level shows an estimate of the amount of ink remaining in the ink cartridges.

To check the ink levels from the printer control panel

● The Ink Level icons on the printer display show an estimate of ink remaining in the ink cartridges.

For more information about the Ink Level icons, see Control panel lights and display icons status on page 7.

To check the ink levels from the HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. In the printer software, click the Estimated Ink Levels tab.

To check the ink levels from the HP printer software (OS X)

1. Open HP Utility.

HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of the hard 
disk.

2. Select the HP DeskJet 4720 series from the list of devices at the left of the window.

3. Click Supplies Status.

The estimated ink levels appear.

4. Click All Settings to return to the Information and Support pane.

NOTE: If you have installed a refilled or remanufactured ink cartridge, or an ink cartridge that has been used 
in another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive a 
low-ink warning message, consider having a replacement ink cartridge available to avoid possible printing 
delays. You do not have to replace the ink cartridges until the print quality is unacceptable.

NOTE: Ink from the ink cartridges is used in the printing process in a number of different ways, including in 
the initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, 
which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the ink 
cartridge after it is used. For more information, see www.hp.com/go/inkusage.
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Order ink supplies
Before ordering cartridges, locate the correct cartridge number.

To locate the cartridge number on the printer

● The cartridge number is located inside the front door.

To locate the cartridge number from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. In the printer software, click Shop, click Shop For Supplies Online, and then follow the on-screen 
instructions.

To find the print cartridge reorder numbers (OS X)

1. Open HP Utility.

NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of 
the hard disk.

2. Click Supplies Info.

The print cartridge ordering numbers appear.

3. Click All Settings to return to the Information and Support pane.

To order original HP supplies for the HP DeskJet 4720 series, go to www.hp.com/buy/supplies . If prompted, 
choose your country/region, and then follow the prompts to find the right cartridges for your printer.

NOTE: Ordering ink cartridges online is not supported in all countries/regions. If it is not available in your 
country/region, you may still view supplies information and print a list for reference when shopping at a local 
HP reseller.
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Replace ink cartridges
To replace the ink cartridges

1. Check that power is on.

2. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.

3. Remove the ink cartridge.

a. Open the front door of the printer.

b. Open the cartridge access door and wait for the print carriage to move to the center of the printer.

c. Press down to release the ink cartridge, and then remove it from the slot.
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4. Insert a new ink cartridge.

a. Remove the ink cartridge from the packaging.

b. Remove the plastic tape using the pull tab.

NOTE: Do not touch the electrical contacts on the ink cartridge.

c. Slide the ink cartridge into the slot until it clicks into place.
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d. Close the cartridge access door.

NOTE: The HP printer software prompts you to align the ink cartridges when you print a 
document after installing the new ink cartridge.

e. Close the front door of the printer.

5. Pull out the output tray and the tray extender.
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Use single-cartridge mode
Use the single-cartridge mode to operate the printer with only one ink cartridge. The single-cartridge mode is 
initiated when an ink cartridge is removed from the ink cartridge carriage.

NOTE: When the printer operates in single-cartridge mode, a message is displayed on the computer screen. 
If the message is displayed and two ink cartridges are installed in the printer, verify that the protective piece 
of plastic tape has been removed from each ink cartridge. When the plastic tape covers the ink cartridge 
contacts, the printer cannot detect that the ink cartridge is installed. If there is no plastic tape on the 
cartridges, try cleaning the cartridge contacts. For information about cleaning ink cartridge contacts, see Ink 
cartridge issues on page 85.

To exit the single-cartridge mode

● Install both the black and tri-color ink cartridges in the printer.
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Cartridge warranty information
The HP cartridge warranty is applicable when the cartridge is used in its designated HP printing device. This 
warranty does not cover HP ink cartridges that have been refilled, remanufactured, refurbished, misused, or 
tampered with.

During the warranty period, the cartridge is covered as long as the HP ink is not depleted and the end of 
warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the 
cartridge as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the printer.

62 Chapter 6   Manage ink cartridges ENWW



Tips for working with cartridges
Use the following tips to work with cartridges:

● To protect the cartridges from drying out, always turn the printer off using the Power button, and wait 
until the Power button light goes out.

● Do not open or untape cartridges until you are ready to install them. Leaving tape on the cartridges 
reduces ink evaporation.

● Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color and 
icon for each slot. Make sure the cartridges snap into place.

● Align the printer for best print quality. See Printing issues on page 88 for more information.

● When the Estimated Ink Levels screen shows one or both cartridges in a low state, consider getting 
replacement cartridges to avoid possible printing delays. You do not need to replace the cartridges until 
print quality becomes unacceptable. See Replace ink cartridges on page 58 for more information.

● If you remove a cartridge from the printer for any reason, try to replace it again as soon as possible. 
Outside of the printer, if unprotected, cartridges begin to dry out.
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7 Connect your printer

● Connect your printer to a wireless network with a router

● Connect wirelessly to the printer without a router

● Wireless settings

● Connect your printer to your computer with a USB cable (non-network connection)

● Change from a USB connection to a wireless network

● Advanced printer management tools (for networked printers)

● Tips for setting up and using a networked printer
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Connect your printer to a wireless network with a router
TIP: To print a wireless quick start guide, press the Information button ( ) for three seconds. 

● Connect your printer to a wireless network using Wi-Fi Protected Setup (WPS)

● Connect your printer to a wireless network using HP printer software

Connect your printer to a wireless network using Wi-Fi Protected Setup (WPS)
Before you can connect your printer to a wireless network using WPS, make sure you have following:

● A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

NOTE: The printer only supports connections using 2.4GHz.

● A computer connected to the wireless network that you intend to connect the printer to. Be sure you 
have installed the HP printer software on the computer.

If you have a WPS router with a WPS push button, follow the Push Button method. If you are not certain your 
router has a push button, follow the PIN method.

To use the Push Button Configuration (PBC) method

1. Press and hold the Wireless button ( ) on the printer for more than three seconds to start WPS push 

mode. The Wireless light starts blinking.

2. Press the WPS button on your router.

NOTE: The product begins a timer for approximately two minutes while a wireless connection is established.

To use the PIN method

1. Press the Wireless button ( ) and Information button ( ) at the same time to print the network 

configuration page, and then locate a WPS PIN.

The WPS PIN is printed at the top of the printed information page.

2. Press and hold the Wireless button ( ) from the printer control panel for more than three seconds. 

The wireless light starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and then enter 
the WPS PIN.
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NOTE: For more information about using the configuration utility, see the documentation provided 
with the router or wireless access point. 

Wait for about two minutes. If the printer connects successfully, the Wireless light stops blinking but remains 
lit.

Connect your printer to a wireless network using HP printer software
To connect the printer to an integrated wireless WLAN 802.11 network, you will need the following:

● A wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: The printer only supports connections using 2.4GHz.

● A computer connected to the wireless network that you intend to connect the printer to.

● Network name (SSID).

● WEP key or WPA Passphrase (if needed).

To connect your printer using HP printer software (Windows)

1. Depending on whether you have installed the HP printer software or not, do one of the following:

If you have not installed the HP printer software on your computer

a. Visit 123.hp.com to download and install the printer software.

NOTE: During the software installation, a USB cable might be required for temporary connection 
between the printer and the computer. Do not connect the USB cable until the printer software 
prompts to do so.

b. When you are prompted, select Wireless, and then follow the on-screen instructions.

If you have the HP printer software installed on your computer

a. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

b. In the printer software, click Utilities.

c. Click Printer Setup & Software.

d. Click Connect a new printer, click Wireless, and then follow the on-screen instructions.

2. After the printer connects successfully, the blue Wireless light stops blinking and remains on.

To connect your printer using HP printer software (OS X)

1. Depending on whether you have installed the HP printer software or not, do one of the following:

If you have not installed the HP printer software on your computer

▲ Visit 123.hp.com to download and install the printer software.
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If you have the HP printer software installed on your computer

a. Double-click the HP Utility icon (located in the Hewlett-Packard folder in the Applications folder 
at the top level of the hard disk).

b. On the menu bar at the top of the screen, choose Setup New Device from the Devices menu, and 
then follow the on-screen instructions.

2. After the printer connects successfully, the blue Wireless light stops blinking and remains on.

To connect a new printer (Windows)

1. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. In the printer software, click Utilities.

3. Select Printer Setup & Software.

4. Select Connect a new printer. Follow the onscreen instructions.

To connect a new printer (OS X)

1. Open System Preferences .

2. Depending on your operating system, click Print & Fax , Print & Scan , or Printers & Scanners in the 
Hardware section.

3. Click + below the list of printers at the left.

4. Select the new printer from the list.
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Connect wirelessly to the printer without a router
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable 
device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct

● Make sure your computer or mobile device has the necessary software.

– If you are using a computer, make sure you have installed the HP printer software.

If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and 
then install the printer software. Select Wireless when prompted by the printer software for a 
connection type.

– If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/global/us/en/eprint/
mobile_printing_apps.html.

● Make sure Wi-Fi Direct for your printer is turned on.

● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

● Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to 
a network using a wireless connection.

● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

To turn Wi-Fi Direct on or off

On the printer control panel, press the Wi-Fi Direct button ( ).

● When Wi-Fi Direct is turned on, the Wi-Fi Direct light is on steady. To find the Wi-Fi Direct name and 
password, press the Information button ( ) to print a printer information page.

NOTE: When you turn on Wi-Fi Direct the first time, the printer automatically prints a Wi-Fi Direct 
guide. The guide provides instructions about how to use Wi-Fi Direct. After that, you can press the Wi-Fi 
Direct button ( ) and the Information button ( ) together to print the Wi-Fi Direct guide. The 

guide may not be available in all languages.

● When Wi-Fi Direct is turned off, the Wi-Fi Direct light is off.

● For more information about the Wi-Fi Direct light status, see Control panel lights and display icons 
status on page 7.

To print from a wireless-capable mobile device that supports Wi-Fi Direct

Make sure you have installed the latest version of HP Print Service Plugin on your mobile device. You can 
download this plugin from the Google Play application store.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with 
the mobile device.
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3. From your mobile device, select a document from a print enabled application, and then select the option 
to print the document.

The list of available printers appears.

4. From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP DeskJet 
4720 series (where ** are the unique characters to identify your printer).

● If the Wi-Fi Direct connection security for the printer is Automatic (the default setting), the mobile 
device will connect to the printer automatically and send the print job.

● If the Wi-Fi Direct connection security for the printer is set to Manual, do one of the following to 
connect to the printer and print.

– If the Wi-Fi Direct light on the printer control panel keeps blinking, press the Wi-Fi Direct 
button ( ). The light will stop blinking and stay on.

– If the printer prints out a page with a PIN code, follow the instruction on the page.

TIP: You can change the Wi-Fi Direct connection security setting for the printer from the embedded 
web server (EWS). For more information, see Open the embedded web server on page 75.

To print from a wireless-capable mobile device that does not support Wi-Fi Direct

Make sure you have installed a compatible printing app on your mobile device. For more information, visit 
www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a 
new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks 
shown such as DIRECT-**-HP DeskJet 4720 series (where ** are the unique characters to identify your 
printer).

Enter the Wi-Fi Direct password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with 
the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new 
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown 
such as DIRECT-**-HP DeskJet 4720 series (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.
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4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless 
network. If the printer has been installed and connected to your computer with a USB cable, follow the 
steps below to install the printer software using the HP Wi-Fi Direct connection.

a. Depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the printer 
name, and then click Utilities.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, select 
the printer name, and then click Utilities.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select 
All Programs, click HP, click the folder of your printer.

b. Click Printer Setup & Software, and then select Connect a new printer.

c. When the Connection Options software screen appears, select Wireless.

Select your HP printer software from the list of detected printers.

d. Follow the on-screen instructions.

5. Print your document.

To print from a wireless-capable computer (OS X)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi on the computer.

For more information, see the documentation provided by Apple.

3. Click the Wi-Fi icon and choose the Wi-Fi Direct name, such as DIRECT-**-HP DeskJet 4720 series (where 
** are the unique characters to identify your printer and XXXX is the printer model located on the 
printer).

If Wi-Fi Direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. Open System Preferences .

b. Depending on your operating system, click Print & Fax , Print & Scan , or Printers & Scanners in 
the Hardware section.

c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed the right column 
beside the printer name), and click Add.
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Wireless settings
You can set up and manage your printer wireless connection and perform a variety of network management 
tasks. This includes printing information about network settings, turning the wireless function on or off, and 
changing wireless settings.

To turn on or off the wireless capability of the printer

Press the Wireless button ( ) to turn on or off the printer wireless capabilities.

● If the printer has an active connection to a wireless network, the Wireless light is on solid blue, and the 
printer display shows the Wireless icon and the Signal Bars icon.

● If wireless is turned off, the Wireless light is off.

● For more information about the wireless status, see Control panel lights and display icons status 
on page 7.

To print the wireless network test report and network configuration page

Press the Wireless button ( ) and the Information button ( ) at the same time.

● The wireless network test report shows the diagnostics results for the status of the wireless network, 
wireless signal strength, detected networks, and more.

● The network configuration page shows the network status, hostname, network name, and more.

To change wireless settings (Windows)

This method is available if you have already installed the printer software.

NOTE: This method requires a USB cable. Do not connect the USB cable until prompted to do so.

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. In the printer software, click Utilities.

3. Click Printer Setup & Software.

4. Select Reconfigure Wireless Settings. Follow the on-screen instructions.

To restore network settings to default settings

● Press the Wireless button ( ) and the Cancel button ( ) from the printer control panel at the same 

time, and then hold them for three seconds.
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Connect your printer to your computer with a USB cable (non-
network connection)

The printer supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the printer with the USB cable

1. Visit 123.hp.com to download and install the printer software.

NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions. When you are prompted, connect the printer to the computer by 
selecting USB on the Connection Options screen.

3. Follow the onscreen instructions.

If the printer software has been installed, the printer will operate as a plug-and-play device.
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Change from a USB connection to a wireless network
If you first set up your printer and installed the software with a USB cable, directly connecting the printer to 
your computer, you can easily change to a wireless network connection. You will need a wireless 802.11b/g/n 
network that includes a wireless router or access point.

NOTE: The printer only supports connections using 2.4GHz.

Before changing from a USB connection to a wireless network, make sure that:

● The printer is connected to your computer with the USB cable until you are prompted to disconnect the 
cable.

● The computer is connected to the wireless network that you intend to install the printer on.

Change from a USB connection to a wireless network (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. In the printer software, click Utilities.

3. Click Printer Setup & Software.

4. Select Convert a USB connected printer to wireless. Follow the on-screen instructions.

To change from a USB connection to a wireless network (OS X)

1. Connect the printer to your wireless network.

2. Use HP Setup Assistant in Applications/Hewlett-Packard/Device Utilities to change the software 
connection to wireless for this printer.
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Advanced printer management tools (for networked printers)
When the printer is connected to a network, you can use the embedded web server (EWS) to view status 
information, change settings, and manage the printer from your computer.

NOTE: You can open and use the EWS without being connected to the Internet. However, some features are 
not available.

NOTE: To view or change some settings, you might need a password.

● Open the embedded web server

● About cookies

Open the embedded web server
You can use one of the following ways to open the embedded web server.

To open the embedded web server through a network

1. From the printer control panel, press the Wireless button ( ) and the Information button ( ) 

together to print the network configuration page.

2. Find out the IP address or hostname of the printer from the network configuration page.

3. In a supported web browser on your computer, type the IP address or hostname assigned to the printer.

For example, if the IP address is 192.168.0.12, type the following address into a Web browser: http://
192.168.0.12.

To open the embedded web server from the HP printer software (Windows)

1. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

2. Click Print & Scan , and then click Printer Home Page (EWS).

To open the embedded web server through Wi-Fi Direct

1. If the Wi-Fi Direct light is off, press the Wi-Fi Direct button ( ) to turn it on. To find the Wi-Fi Direct 

name and password, press the Information button ( ) to print a printer information page.

2. From your wireless computer, turn wireless on, search for and connect to the Wi-Fi Direct name, for 
example: DIRECT-**-HP DeskJet 4720 series. Enter the Wi-Fi Direct password when prompted.

3. In a supported web browser on your computer, type the following address: http://
192.168.223.1.

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are 
browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have 
configured the EWS language, a cookie helps remember which language you have selected so that the next 
time you access the EWS, the pages are displayed in that language. Some cookies (such as the cookie that 
stores customer-specific preferences) are stored on the computer until you clear them manually.
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You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is 
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to 
remove unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of the following 
features:

● Starting where you left the application (especially useful when using setup wizards)

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see 
the documentation available with your Web browser.
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Tips for setting up and using a networked printer
Use the following tips to set up and use a networked printer:

● When setting up the wireless networked printer, make sure your wireless router or access point is 
powered on. The printer searches for wireless routers, then lists the detected network names on the 
computer.

● If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from the VPN 
before you can access any other device on your network, including the printer.

● Learn more about configuring your network and the printer for wireless printing. Click here to go online 
for more information.

● Learn how to find your network security settings. Click here to go online for more information.

● Learn about the HP Print and Scan Doctor. Click here to go online for more information.

NOTE:  This utility is only available for Windows operation system. 

● Learn how to change from a USB to wireless connection. Click here to go online for more information.

● Learn how to work with your firewall and antivirus programs during printer setup. Click here to go online 
for more information.
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8 Solve a problem

This section contains the following topics:

● Jams and paper-feed issues

● Ink cartridge issues

● Printing issues

● Copy issues

● Scan issues

● Network and connection issues

● Printer hardware issues

● Control panel error codes

● HP support
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Jams and paper-feed issues
What do you want to do?

Clear a paper jam

Solve paper jam issues. Use an HP online troubleshooting wizard

Instructions for clearing paper jams and resolving issues with paper or the paper feed.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing paper jams

Paper jams can occur in several locations.

To clear a paper jam from the input tray

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Pull the paper gently out of the input tray.

3. Make sure there is no foreign object in the paper path, and then reload paper.

NOTE: The input tray shield can prevent foreign debris from falling into the paper path and causing 
serious paper jams. Do not take down the input tray shield. 

4. Press the Resume button ( ) on the control panel to continue the current job.

To clear a paper jam from the output tray

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.
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2. Pull the paper gently out of the output tray.

3. Press the Resume button ( ) on the control panel to continue the current job.

To clear a paper jam from the cartridge access area

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Remove the jammed paper.

a. Press the Power button ( ) to turn off the printer.

b. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.

c. Open the front door of the printer.

d. Open the cartridge access door.
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e. If the print carriage is in the center of the printer, slide it to the right.

f. Remove the jammed paper.

g. Close the cartridge access door, and then close the front door.

h. Pull out the output tray and the tray extender.

3. Press the Power button ( ) to turn on the printer.

To clear a paper jam inside of the printer

1. Press the Cancel button ( ) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Press the Power button ( ) to turn off the printer.
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3. Turn the printer over, locate the cleanout door on the bottom of the printer, and then pull both tabs on 
the cleanout door to open it.

4. Remove the jammed paper.

5. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

6. Turn the printer over, and then press the Power button ( ) to turn on the printer.

Clear a print carriage jam

Resolve a print carriage jam. Use an HP online troubleshooting wizard

If something is blocking the print carriage or it does not move easily, get step-by-step instructions.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing a print carriage jams

▲ Remove any objects, such as paper, that are blocking the print carriage.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when 
removing jammed paper from inside the printer.
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Learn how to avoid paper jams
To help avoid paper jams, follow these guidelines.

● Do not overfill the input tray.

● Remove printed papers from the output tray frequently.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.

● Do not force paper too far down in the input tray.

● Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until the out 
of paper message appears before adding paper.

Solve paper-feed problems
What kind of problem are you having?

● Paper is not picked up from the input tray   

– Make sure paper is loaded in the input tray. For more information, see Load media on page 15.

– Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

– Make sure paper in the input tray is not curled. Uncurl paper by bending it in the opposite direction 
of the curl.

● Pages are skewing   

– Make sure the paper is loaded in the far-right side of the input tray and the paper-width guide is fit 
against the left side of the paper.

– Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

– Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

– Make sure the input tray is not overloaded with paper.

– Make sure the pieces of the loaded paper are not sticking together.

– Use HP paper for optimum performance and efficiency.
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Ink cartridge issues
Identify whether an ink cartridge has a problem

To identify whether an ink cartridge has a problem, check the status of the Ink Alert light and the 
corresponding Ink Level icon. For more information, see Control panel lights and display icons status 
on page 7.

If you get an ink cartridge problem message from the printer software that states at least one of the 
cartridges has a problem, do the following to identify whether a cartridge has a problem.

1. Remove the black cartridge and then close the cartridge access door.

● If the Ink Level icon for the tri-color cartridge blinks, the tri-color cartridge has a problem.

● If the Ink Level icon for the tri-color cartridge does not blink, the tri-color cartridge does not have a 
problem.

2. Install the black cartridge back in the printer, remove tri-color cartridge, and then close the cartridge 
access door.

● If the Ink Level icon for the black cartridge blinks, the black cartridge has a problem.

● If the Ink Level icon for the black cartridge does not blink, the black cartridge does not have a 
problem.

Fix ink cartridge problems
If an error occurs after a cartridge is installed, or if a message indicates a cartridge problem, try removing the 
ink cartridges, verifying the protective piece of plastic tape has been removed from each ink cartridge, and 
then reinserting the ink cartridges. If this does not work, clean the cartridge contacts. If the problem is still 
not resolved, replace the ink cartridges. For information about replacing ink cartridges, see Replace ink 
cartridges on page 58.

To clean cartridge contacts

CAUTION: The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are 
reinstalled in the printer as soon as possible. It is not recommended to leave the ink cartridges outside of the 
printer longer than 30 minutes. This could result in damage to the printhead or the ink cartridges.

1. Check that power is on.

2. Close the output tray extender, and then rotate the output tray clockwise to stow it in the printer.
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3. Open the front door of the printer.

4. Open the cartridge access door and wait for the print carriage to move to the center of the printer.

5. Remove the ink cartridge indicated in the error message.

6. Clean the cartridge contacts and printer contacts.

a. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on 
the ink cartridge.

The electrical contacts are the small gold-colored dots on the ink cartridge.

b. Wipe only the contacts with a dry swab or lint-free cloth.

CAUTION: Be careful to wipe only the contacts, and do not smear any of the ink or other debris 
elsewhere on the ink cartridge.
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c. On the inside of the printer, locate the contacts for the cartridge.

The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the ink 
cartridge.

d. Use a dry swab or lint-free cloth to wipe the contacts.

7. Reinstall the ink cartridge.

8. Close the cartridge access door, and then close the front door.

9. Check if the error message has gone away. If you still receive the error message, turn the printer off, and 
then on.

NOTE: If one ink cartridge is causing problems, you can remove it and use the single-cartridge mode to 
operate the printer with only one ink cartridge.

Fix ink cartridge incompatible issues
The ink cartridge is not compatible with your printer. This error can occur if you install an HP Instant Ink 
cartridge into a printer that has not been enrolled in the HP Instant Ink program. It can also occur if the HP 
Instant Ink cartridge was previously used in a different printer enrolled in the HP Instant Ink program.
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Printing issues
What do you want to do?

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Troubleshoot problems with 
print jobs not printing.

Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer is not responding or printing.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable to print, 
try the following in order:

1. Check for error messages from the printer software and resolve them by following the on-screen 
instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable. If 
your computer is connected to the printer with a wireless connection, confirm that the connection is 
working.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending upon your operating system, do one of the following:

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See 
what's printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer 
Offline.

d. If you made any changes, try to print again.
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4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending upon your operating system, do one of the following:

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending upon your operating system, do one of the following:

Windows 8.1 and Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the 
Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or 
tap OK.

Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.
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Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance, 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending upon your operating system, do one of the following:

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to 
confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the 
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.
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To resolve print issues (OS X)

1. Check for error messages and resolve.

2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. In System Preferences, click Print & Fax.

b. Click the Open Print Queue button.

c. Click a print job to select it.

Use the following buttons to manage the print job:

● Delete: Cancel the selected print job.

● Hold: Pause the selected print job.

● Resume: Continue a paused print job.

● Pause Printer: Pause all print jobs in the print queue.

d. If you made any changes, try to print again.

4. Restart the computer.

Fix print quality issues

Step-by-step instructions for resolving most print quality issues. Troubleshoot print quality issues online

Read general instructions in the Help for resolving print quality issues

NOTE: To protect the cartridges from drying out, always turn the printer off using the Power button, and 
wait until the Power button light goes out. 

To improve print quality (Windows)

1. Make sure you are using original HP ink cartridges.

2. Check the printer software to make sure you have selected the appropriate paper type from the Media 
drop-down list and print quality from the Quality Settings drop-down list.

In the printer software, click Print & Scan and then click Set Preferences to access the print properties.

3. Check the estimated ink levels to determine if the ink cartridges are low on ink.

For more information, see Check estimated ink levels on page 56. If the ink cartridges are low on ink 
consider replacing them.

4. Check the paper type.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For 
more information, see Paper basics on page 21.
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Always make sure the paper you are printing on is flat. For best results when printing images, use HP 
Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, 
dry place. When you are ready to print, remove only the paper you plan to use immediately. When you 
have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper 
from curling.

5. Align the ink cartridges.

To align the ink cartridges

a. Load letter or A4 unused plain white paper into the input tray.

b. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the 
printer toolbox.

The printer toolbox appears.

d. Click Align Ink Cartridges on the Device Services tab.

The printer prints an alignment page.

e. Follow the on-screen instructions to load the cartridge alignment page print side down on the 
scanner glass, and then click Scan to scan the alignment page.

The printer aligns the ink cartridges. Recycle or discard the cartridge alignment sheet.

6. Print a diagnostics page if the ink cartridges are not low on ink.

To print a diagnostics page

a. Load letter or A4 unused plain white paper into the input tray.

b. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the 
printer toolbox.

d. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.
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e. Review the blue, magenta, yellow, and black boxes on the diagnostics page.

7. Clean the ink cartridges, if the diagnostic page shows steaks or missing portions of the color and black 
boxes.

To clean the ink cartridges

a. Load letter or A4 unused plain white paper into the input tray.

b. Open the printer software. For more information, see Open the HP printer software (Windows) 
on page 23.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the 
Printer Toolbox.

d. Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.

To improve print quality (OS X)

1. Make sure you are using original HP cartridges.

2. Make sure you have selected the appropriate paper type and print quality in the Print dialog.

3. Check the estimated ink levels to determine if the cartridges are low on ink.

Consider replacing the print cartridges if they are low on ink.
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4. Check the paper type.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For 
more information, see Paper basics on page 21.

Always make sure the paper you are printing on is flat. For best results when printing images, use HP 
Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, 
dry place. When you are ready to print, remove only the paper you plan to use immediately. When you 
have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper 
from curling.

5. Align the printer cartridges.

To align print cartridges from the software

a. Load Letter or A4 plain, white paper in the paper tray.

b. Open HP Utility.

NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top 
level of the hard disk.

c. Select the HP DeskJet 4720 series from the list of devices at the left of the window.

d. Click Align.

e. Click Align and follow the on-screen instructions.

f. Click All Settings to return to the Information and Support pane.

6. Print a test page.

To print a test page

a. Load Letter or A4 plain, white paper in the paper tray.

b. Open HP Utility.

NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top 
level of the hard disk.

c. Select the HP DeskJet 4720 series from the list of devices at the left of the window.

d. Click Test Page.

e. Click the Print Test Page button, and follow the on-screen instructions.

Check the test page for jagged lines in the text or streaks in the text and colored boxes. If you are 
seeing jagged lines, or streaks, or no ink in portions of the boxes, then automatically clean the 
cartridges.

7. If the diagnostic page shows steaks or missing portions of the text or colored boxes, clean the print 
cartridges automatically.
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To automatically clean the print head

a. Load Letter or A4 plain, white paper in the paper tray.

b. Open HP Utility.

NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top 
level of the hard disk.

c. Select the HP DeskJet 4720 series from the list of devices at the left of the window.

d. Click Clean Printheads.

e. Click Clean, and follow the on-screen instructions.

CAUTION: Clean the print head only when necessary. Unnecessary cleaning wastes ink and 
shortens the life of the print head.

NOTE: If print quality still seems poor after you complete cleaning, try aligning the printer. If 
print quality problems persist after cleaning and aligning, contact HP support.

f. Click All Settings to return to the Information and Support pane.
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Copy issues
Troubleshoot copy problems. Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer does not create a copy, or if your printouts are low quality.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Tips for copy and scan success on page 54
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Scan issues
HP Print and Scan 
Doctor

The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Solve scan problems Use an HP online troubleshooting wizard

Get step-by-step instructions if you cannot create a scan or if your scans are low quality.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Tips for copy and scan success on page 54
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Network and connection issues
What do you want to do?

Fix wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Use an HP online 
troubleshooting wizard

● Troubleshoot your wireless problem, whether your printer has never been connected or it was 
connected and is no longer working.

● Troubleshoot a firewall or antivirus issue, if you suspect that it is preventing your computer from 
connecting to the printer.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for wireless troubleshooting

▲ Press the Wireless button ( ) and the Information button ( ) at the same time to print the 

wireless network test report and network configuration page.

Find network settings for wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that can tell you the network name (SSID) and 
password (network key).

NOTE:  This utility is only available for Windows operation system. 

Use an HP online troubleshooting 
wizard

Learn how to find your network name (SSID) and wireless password.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Fix Wi-Fi Direct connection

Use an HP online troubleshooting wizard Troubleshoot your Wi-Fi Direct problem or learn how to configure Wi-Fi Direct.

NOTE: The HP online troubleshooting wizards may not be available in all languages.
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Read general instructions in the Help for Wi-Fi Direct troubleshooting

1. Make sure that the Wi-Fi Direct light on the printer control panel is on. If the light is off, press the Wi-Fi 
Direct button ( ) to turn it on.

2. From your wireless computer or mobile device, turn on the Wi-Fi connection, and then search for and 
connect to the Wi-Fi Direct name of your printer.

3. Enter the Wi-Fi Direct password when prompted.

4. If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

Convert USB connection to wireless
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue 
automatically.

NOTE:  This utility is only available for Windows operation system. 

Use an HP online troubleshooting 
wizard

Convert a USB connection to wireless or Wi-Fi Direct.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Change from a USB connection to a wireless network on page 74
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Printer hardware issues
Close cartridge access door

● Cartridge door must be closed to begin printing.

The printer shuts down unexpectedly

● Check the power and power connections.

● Make sure the printer's power cord is connected firmly to a functioning power outlet.

NOTE: When Auto-Off is enabled, the printer will automatically turn off after 2 hours of inactivity to help 
reduce energy use. For more information, see Auto-Off on page 26.

Resolve printer failure

● Turn the printer off, then on. If that does not resolve the problem, contact HP.
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Control panel error codes
If the Number of copies icon on the printer display is alternating between the letter E and a number, it 
indicates the printer is in an error state. The letter E and the number work as error codes. For example, if the 
Number of copies icon is alternating between the letter E and the number 4, it indicates that a paper jam has 
occurred.

To identify the error code and its corresponding solutions, see the information about the Number of copies 
icons in Control panel lights and display icons status on page 7.
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HP support
For the latest product updates and support information, visit the HP DeskJet 4720 series support website at 
www.hp.com/support. HP online support provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation 
that came in the box with your printer.

HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view 
questions posted by other HP customers, or sign in and post your own questions and comments.

Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.

Contact HP
If you need help from an HP technical support representative to solve a problem, visit the Contact Support 
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted 
support for out-of warranty customers may require a fee):

Chat with an HP support agent online.

Call an HP support agent.

When contacting HP support, be prepared to provide the following information:

● Product name (Located on the printer, such as HP DeskJet Ink Advantage Ultra 4729)

● Product number (located inside the front door)

● Serial number (located on the back or bottom of the printer)
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Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.

Additional warranty options
Extended service plans are available for the HP DeskJet 4720 series at additional costs. Go to www.hp.com/
support , select your country/region and language, then explore the extended warranty options available for 
your printer.
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A Technical information

The technical specifications and international regulatory information for the HP DeskJet 4720 series are 
provided in this section.

For additional specifications, see the printed documentation that came with the HP DeskJet 4720 series.

This section contains the following topics:

● HP Company notices

● Specifications

● Environmental product stewardship program

● Regulatory notices
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HP Company notices
The information contained herein is subject to change without notice.

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior 
written permission of HP, except as allowed under the copyright laws. The only warranties for HP products 
and services are set forth in the express warranty statements accompanying such products and services. 
Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical 
or editorial errors or omissions contained herein.

© Copyright 2018 HP Development Company, L.P.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.
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Specifications
Technical specifications for the HP DeskJet 4720 series are provided in this section. For more product 
specifications, see the Product Data Sheet at www.hp.com/support .

System requirements

● For information about software and system requirements or future operating system releases and 
support, visit the HP online support website at www.hp.com/support .

Environmental specifications

● Recommended operating temperature range: 15ºC to 30ºC (59ºF to 86ºF)

● Allowable operating temperature range: 5ºC to 40ºC (41ºF to 104ºF)

● Humidity: 15% to 80% RH non-condensing; 28ºC maximum dewpoint

● Nonoperating (Storage) temperature range: –40ºC to 60ºC (–40ºF to 140ºF)

● In the presence of high electromagnetic fields, it is possible the output from the HP DeskJet 4720 series 
may be slightly distorted

● HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected 
noise due to potential high electromagnetic fields

Input tray capacity

● Plain paper sheets (80 g/m2 [20lb]): Up to 60

● Envelopes: Up to 5

● Index cards: Up to 20

● Photo paper sheets: Up to 20

Output tray capacity

● Plain paper sheets (80 g/m2 [20lb]): Up to 25

● Envelopes: Up to 5

● Index cards: Up to 10

● Photo paper sheets: Up to 10

Paper size

● For a complete list of supported media sizes, see the printer software.

Paper weights

● Plain Paper: 64 to 90 g/m² (16 to 24 lb)

● Envelopes: 75 to 90 g/m² (20 to 24 lb)

● Cards: Up to 200 g/m² (110-lb index maximum)

● Photo Paper: Up to 280 g/m² (75 lb)
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Print specifications

● Print speeds vary according to the complexity of the document

● Method: drop-on-demand thermal inkjet

● Language: PCL3 GUI

Copy specifications

● Digital image processing

● Copy speeds vary according to the complexity of the document and model

Scan specifications

● Resolution: up to 1200 x 1200 ppi optical

For more information about ppi resolution, see the scanner software.

● Color: 24-bit color, 8-bit grayscale (256 levels of gray)

● Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Cartridge yield

● Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information

● If you have Internet access, you can access acoustic information from the HP website.
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Environmental product stewardship program
HP is committed to providing quality products in an environmentally sound manner. Design for recycling has 
been incorporated into this product. The number of materials has been kept to a minimum while ensuring 
proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and 
other connections are easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair. For more information, visit HP's Commitment 
to the Environment website at:

www.hp.com/hpinfo/globalcitizenship/environment

● Eco-Tips

● European Union Commission Regulation 1275/2008

● Paper use

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Disposal of waste equipment by users

● Chemical substances

● Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)

● The Table of Hazardous Substances/Elements and their Content (China)

● Restriction of hazardous substance (Ukraine)

● Restriction of hazardous substance (India)

● EPEAT

● China SEPA Eco Label User Information

● China Energy Label for Printer, Fax and Copier

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. Please visit the HP 
Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

European Union Commission Regulation 1275/2008
For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.
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Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products. For more information regarding recycling of HP products, 
please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more 
information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.
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Declaration of the Presence Condition of the Restricted Substances Marking 
(Taiwan)

限用物質含有情況標示聲明書

Declaration of the Presence Condition of the Restricted Substances Marking

單元 Unit

限用物質及其化學符號

Restricted substances and its chemical symbols

鉛

Lead

(Pb)

汞

Mercury

(Hg)

鎘

Cadmium

(Cd)

六價鉻

Hexavalent 
chromium

(Cr+6)

多溴聯苯

Polybrominated 
biphenyls

(PBB)

多溴二苯醚

Polybrominate
d diphenyl 

ethers

(PBDE)

外殼和紙匣

(External Casings and Trays)

0 0 0 0 0 0

電線 (Cables) 0 0 0 0 0 0

印刷電路板

(Printed Circuit Boards)

－ 0 0 0 0 0

列印引擎(Print Engine) － 0 0 0 0 0

列印機組件 (Print Assembly) － 0 0 0 0 0

噴墨印表機墨水匣 (Print 
Supplies)

0 0 0 0 0 0

列印機配件 (Print Accessory) － 0 0 0 0 0

備考 1.〝超出 0.1 wt %〞及〝超出 0.01 wt %〞係指限用物質之百分比含量超出百分比含量基準值。

Note 1: “Exceeding 0.1 wt %” and “exceeding 0.01 wt %” indicate that the percentage content of the restricted substance exceeds the 
reference percentage value of presence condition.

備考 2.〝0〞係指該項限用物質之百分比含量未超出百分比含量基準值。

Note 2: “0” indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of 
presence.

備考 3.〝－〞係指該項限用物質為排除項目。

Note 3: The “−” indicates that the restricted substance corresponds to the exemption.

若要存取產品的最新使用指南或手冊，請前往 www.support.hp.com。選取搜尋您的產品，然後依照 畫
面上的指示繼續執行。

To access the latest user guides or manuals for your product, go to www.support.hp.com. Select Find your 
product, and then follow the onscreen instructions.
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The Table of Hazardous Substances/Elements and their Content (China)

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)
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EPEAT

China SEPA Eco Label User Information
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China Energy Label for Printer, Fax and Copier
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Regulatory notices
The HP DeskJet 4720 series meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory model identification number

● FCC statement

● Notice to users in Korea

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● Noise emission statement for Germany

● Visual display workplaces statement for Germany

● European Union Regulatory Notice

● Declaration of conformity

● Regulatory wireless statements

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory 
Model Number for your product is SNPRH-1501. This regulatory number should not be confused with the 
marketing name (HP DeskJet Ink Advantage Ultra 4729 All-in-One Printer, etc.) or product numbers (F5S65A, 
F5S66A, etc.).
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FCC statement

Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord
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Noise emission statement for Germany

Visual display workplaces statement for Germany

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP Deutschland GmbH, HQ-TRE, Schickardstrasse 32, 71034 Boeblingen, Germany

Products with wireless functionality

EMF

● This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of 
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

● This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, 
Norway and Switzerland.
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Declaration of conformity
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Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Brazil

● Notice to users in Canada

● Notice to users in Mexico

● Notice to users in Taiwan

● Notice to users in Japan

● Notice to users in Korea

Exposure to radio frequency radiation

Notice to users in Brazil
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Notice to users in Canada

Notice to users in Mexico
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Notice to users in Taiwan

Notice to users in Japan

Notice to users in Korea
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